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Getting Started

WinFrotz is a Z-Machine interpreter (or more properly, emulator) that lets you load 
interactive fiction story files and play them under Windows 95 or Windows NT.    The most 
widely known examples of interactive fiction are the old Infocom adventure games; WinFrotz 
will play almost all of those (see compatibility notes).

However there are plenty of more recent interactive fictions works available; in fact, there 
are more works of interactive fiction released after Infocom ceased producing them than 
Infocom released themselves.    This is mainly do to the freely available compilers to create 
these files.

To get going with WinFrotz all you need to do is track down some story files and load them 
up. There are a few in the WinFrotz distribution archive you can try out, or if you have one of 
the Infocom games (including the re-release of them by Activision) all you need to do is load 
the “.dat” file from it and you can play.    Or you can go get some of the more recent, public 
domain and shareware story files from the interactive fiction repository on the internet at 
ftp.gmd.de.

For an easy starting point you can head to the WinFrotz web pages which have links and 
pointers for locations of story files, background info, etc.    They are located at:

http://www.cris.com/~Twist/WinFrotz/

(Obtaining story files is more completely discussed in Obtaining Story Files)
Have fun!



File menu commands

The File menu offers the following commands:

Restart Restart the current story file.
Open Story Opens a new story file
Open Opens a data file such as a saved game (only works after a story is 

loaded)
Save Saves an opened document using the same file name.
Print Prints a document.
Print 
Preview

Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Exit Exits WinFrotz.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Paste Link Pastes from the clipboard a link to data in another application.
Insert New 
Object

Inserts and embeds an object, such as a chart or an equation in a document.

Links List and edit links to embedded documents.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Fonts Select the fonts used for WinFrotz
Display 
Options

Control the WinFrotz screen properties and how the 
program chooses to indicate various display styles

Graphics Control how WinFrotz handles V6 (graphical) Infocom 
games such as Journey, Arthur, etc.

Colors menu commands

This menu consists of six options: Foreground, Background, Status Foreground, Status 
Background, Emphasis Text, and Bold Text.    Selecting any of these will bring up a standard 
Windows Color dialog.    If you are in dual color mode (the default, and changed by the 
Display Options dialog in the View menu) only the first two choices will be available.

It is possible to select a color and not immediately see an effect; for instance, if you change 
the Bold color and have told WinFrotz via the Display Options dialog to print bold as an 
actual bold font, you won’t see any difference.    Also, many games simply do not have Bold 
or Emphasis text in them.

The “Status” colors are slightly misnamed; what you are really doing is setting the colors for 
reverse printed text.    Generally the status area is printed completely in reverse, but 
sometimes text is also printed in the display are that way as well.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.
Options menu commands

The options menu offers the following commands, which affect the way WinFrotz plays a 
story file:

Aliases Manages aliases for text input.
Debuggin
g

Sets various debug flags for the Z-machine.

Sound Controls volume, and whether WinFrotz plays sounds at all.



The Z-Machine

The Z-Machine was a computer that didn’t exist, but had plenty of programs written for it.    
This was an idea of the original founders of Infocom; to come up with a computer design 
specifically built to play interactive fiction (adventure) stories.    They designed the 
“operating system” of this mythical computer to support what they needed to write 
adventure games and that was pretty much it.

When they wrote actual adventures, they of course didn’t have a Z-Machine handy, so 
instead programs were written on other computers that emulated the behavior of the Z-
machine.    Since the capabilities required were clearly defined by the Z-Machine structure 
itself, it made porting their adventure games to a variety of platforms easier.    All they had 
to do was write a Z-Machine emulator for the platform in question and they would then be 
able to run all the Infocom adventures.

This worked out well for people who wanted to play the Infocom adventures later on.    The 
same principle that made Z-Machine emulators versatile for Infocom works for us today; 
WinFrotz is basically a Z-Machine emulator designed specifically for Windows.    Additionally, 
after Infocom more or less ceased to exist, programmers reverse engineered the capabilities
of the Z-Machine and wrote their own compilers to create Z-Machine code.    So today it is 
easy to create a Z-Machine program; and since so many Z-Machine emulators exist you can 
be assured a Z-Machine program will run on a whole variety of computer types, all the way 
from advanced Unix workstations to palmtop machines.



Restart command (File menu)

Use this command to restart the current story file. You will begin from the beginning as if you
had just loaded the story. It is not required to Restart before loading a saved game position.

You can open a different story file from the one you are playing using the Open Story 
command.

Shortcuts

Toolbar:



Starting a Story

To start a story file, you simply have to open it using the File menu option Open Story.    After
it is opened WinFrotz will automatically start the story at the beginning, which usually means
displaying some text for you to read as an introduction.    If you have previously played the 
same story file and want to pick up where you left off, you can load a saved game using the 
Open command from the File menu.



Open Story command (File menu)

Use this command to open a story file from disk. WinFrotz will prompt you for confirmation if 
you already have a story loaded and choose to play a different one.

Opening a story is accomplished using the standard Windows File Open dialog

Shortcuts

Toolbar:



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
.dat,.z3,.z5,.zip (etc.) Story files
(Do not confused Z-Machine .zip files with compressed .zip files. Infocom was 
using this extension long before PkWare invented ZIP - WinFrotz cannot load compressed
files).
.sav Saved game file
.frc Alias list
.rec Recording file

Drives
Select the drive in which WinFrotz stores the file that you want to open. 

Directories
Select the directory in which WinFrotz stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save data from your session, such as a saved game, alias list, 
recordingtranscript. In each case WinFrotz will provide you with a standard dialog box and a 
suggested file name.    While you can change the base file name to anything you like, it’s 
recommended that you leave the extension as is so finding the file will be easier when you 
want to load it.

Recording files are something of a special case.    To correctly save a recording file you will 
need to use the File/Save/Recording menu twice, once to start the recording and once to 
stop it.    Otherwise WinFrotz wouldn’t be able to tell exactly how much you want to record.    
There is also a hot-key for recording: Alt-R.

Shortcuts

Toolbar:
(The toolbar shortcut will automatically select “save game” only, for others you need to 
use the menu option)



Open command (File menu)

Use this command to open data files other than the stories themselves, such as a previously 
saved game, alias list for your current story file, or a recording of actions from this story.

If you have an alias file in the original directory containing the story, and it is named with 
the same base name as the story itself, it will be loaded automatically when the story is 
loaded. So if your story file was ZORK1.DAT and there was an alias file of ZORK1.FRC in the 
same directory, there is no need to load it (it was loaded when ZORK1.DAT was). This does 
not apply to recording or saved games.

Opening operations are accomplished using the standard Windows File Open dialog



Saved game (.sav extension)

Saved games will save your position in the story (including any inventory items, etc.).    Later
you can reload the saved game file (with the appropriate story file already loaded) and 
WinFrotz will pick up in the exact spot you left off with the save.

Save early and save often.    Saved game files are small and it is possible in many games 
(particularly the old Infocom ones) to get into no-win situations without being aware of it at 
the time.



Story File (.dat, .z? extension)

Story files are the data that WinFrotz works with. They are often thought of as “adventures” 
because that was used to describe all of the early Infocom products; however there have 
since been many story files that are not adventures in the classic sense.

An example of a story file might be Planetfall (one of the Infocom adventures) or Curses, a 
much more recent work of interactive fiction. 

Note: Do not confused Z-Machine .zip files with compressed .zip files. Infocom was using 
this extension long before PkWare invented ZIP - WinFrotz cannot load compressed files).



Recording File (.rec extension)

A recording file keeps a list of the commands that you type in to WinFrotz, so you can read 
them in later and play them back in the exact sequence you typed them in the first time.

Recording files are occasionally useful over saved games because they will display all of the 
story text from one point to the next; whereas a saved game simply puts you at the spot 
where it was saved.



Transcript

A transcript is a recording of the text to appear in window 0 (the main text window) for the 
time you have been playing.    WinFrotz maintains a cumulative transcript of everything that 
has occured for the current story file, but the scrollback buffer only displays about 32K of 
that.    Saving the transcript allows you to view the entire contents.



Alias File (.frc extension)

Alias files keep a record of abbreviations of your choosing for commonly typed commands in 
a game. For instance, instead of typing in “the robot form in slot one” repeatedly you might 
decide to abbreviate it “rbf”.    An alias file will permanently record that abbreviation so it is 
available for you next time you run that story file.

Take care in picking aliases; remember many objects can be referred to by shortened 
versions of their own name.    Abbreviating “sailor” “sai” and having the game confuse that 
for the word “sail” for instance.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    WinFrotz adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your WinFrotz session.    You can also use the Close command on 
the application Control menu.    WinFrotz prompts you to save documents with unsaved 
changes when you select File/Exit but not when you use Alt+F4 or the application Control 
menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

As of this writing WinFrotz does not support Windows style Undo, however it does support an
undo hotkey (Alt+U) which will undo your last type action in the story.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Redo command (Edit menu)

WinFrotz does not support Redo



Cut command (Edit menu)

WinFrotz does not yet support the cut command in the main window.    To copy text, use the 
Scrollback buffer (Ctrl-L), highlight the text, and Ctrl-C to copy it.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

WinFrotz does not yet support the copy command in the main window.    To cut text, use the 
Scrollback buffer (Ctrl-L), highlight the text, and Ctrl-C to copy it..

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Pastes text from the clipboard into the current input line.

Shortcuts

Toolbar:
Keys: CTRL+V



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in WinFrotz, such as File Open.    A check mark appears next to the
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in WinFrotz,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    WinFrotz displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, WinFrotz displays the Save As dialog box.

Print the active document.

Remove selected data from the document and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.

Reverse the last editing.    Note:    You cannot undo some actions.



Status Bar command (View menu)

Use this command to display and hide the Status Bar.    Typically you should leave this on, as 
it displays valuable data such as the action to be selected by the current menu item, 
dimensions of your screen, and various keyboard states.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the WinFrotz window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
??x?? Character dimensions of the screen
UNLOCK or LOCK Shows whether the screen is “locked” to prevent resizing.
INS or OVR Text insertion mode is selected, or overstrike mode is selected
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.
??:?? ?? The current time (real, not from the game) in AM/PM mode.



Font Choices (View Menu)

From the “Fonts” item on the View menu, you can choose either your Display Font or your 
Status Font.



Display Font( View Menu; Fonts)

The display font is the font uses for the primary display text (in Z-Machine code this is 
window 0).    For most works of interactive fiction the screen is typically split into two areas; 
with the primary display (window 0) being most of the lower portion of the screen and the 
status area (window 1 or 7) occupying the upper portion.    The display font will change the 
font that is displayed in the lower portion of the window.

WinFrotz won’t allow you to change the display font within a game unless you are currently 
inputting a line of text; you can’t change the font at a “MORE” prompt for instance or while 
the screen is printing.    You can always change the font if there is no story loaded.    If you 
change the font while a game is playing, it will affect all text printing in window 0 from that
point onward, not the text that is already on the screen.    However if you have some text 
on the input line at the time you change the font, that will be reprinted with the newer font, 
which can work well to test the appearance of the new font you’ve selected.

Note that while the screen format described above holds as a general rule it is not applicable
to all games; there is no specific requirement that the bottom part of the screen be window 
0 or even that window 0 be displayed at all.    If you are running a story file that only runs 
window 1 for example, changing the display font won’t produce any visible results.



Status Font (View Menu; Fonts)

The status font is the font generally used for a status area at the top of the screen common 
to most story files.    There are special restrictions to the status font:

* The status font must be fixed-pitch; WinFrotz will enforce this by only allowing you 
to choose fonts of the appropriate type.

* A status font cannot be selected that is too large for the current display; that is, if 
the status area were re-printed with the selected font and the result was wider than the total
width of the Windows desktop, WinFrotz will complain and ask you to re-select the font.    If 
the resulting display would fit on the desktop, WinFrotz will resize your screen to new 
required size.    This is required because almost no games work correctly when the status 
area is resized after a game is started; it must remain the same size (in character 
dimensions) as it was when the story was first run.

* Some version 4 and 5 Z-Machine games may produce errors if you change the 
status font on the fly, epecially if you choose nonsensical values (very large or very small 
fonts). WinFrotz attempts to prevent you from making any bad mistakes here - but if things 
go wrong after you change the status font, change it back to the size it was before.

Having different sized status and display fonts was never really a feature the Z-Machine was 
designed to support.    The most compatible way to run WinFrotz (and the settings that most 
closely resemble the platforms the Z-Machine was developed on) is to run the same fixed 
pitch font for the status and display areas.    However there are only a few cases where doing
otherwise causes problems, and they are generally outweighed by the much more readable 
output when larger, variable pitch fonts are used.

There are several games that will use the “status font” in the regular display area - the 
status font is really the Z-Machine fixed font.    WinFrotz supports this with no problem.    
Generally it is desirable to have a status font that is smaller than the display font.

Do not confuse the Z-Machine status area, generally at the top of the WinFrotz display but 
not required (and so not present in some story files) with the status bar that is maintained 
by Windows at the bottom of the screen.



Display Options (View menu)
This dialog box controls various aspects of the WinFrotz display.
Show Emphasis/Bold as:
The left hand categories, “Show Emphasis as:” and “Show Bold as:” control what WinFrotz 
will do when asked to print either Emphasis or Bold fonts by the story file.    You can choose 
to print these fonts as their specific font style (Emphasis or Bold), print them like normal text
but with a special color (selected from Colors menu), or to show no special effect at all.    In 
addition for Emphasis you can tell WinFrotz to display it as underline, as this was an option 
on some Z-Machine interpreters in the past.

Display Mode:
Selecting the Color options above or selecting “Use full color” in the right hand “Display 
Mode” area will result in WinFrotz prompting you to make sure you wish to make that 
change.    Full color mode allows a whole variety of color options but slows WinFrotz down 
considerably.    How much the program is slowed down will depend on the color resolution of 
your Windows desktop; truecolor being the slowest.    This should be an issue only on the 
slowest of machines capable of running Win95 or NT. In general however much slower it is in
color mode, WinFrotz will still print and react faster than you can read or type.

Full color mode will look better for those with Plus! Installed or WinNT 4.X users, because the
printed fonts can be automatically anti-aliased if you have selected smooth font display from
the Windows control panel.

Updates:
“Updates” is a setting that applies to both full color and dual color modes; it controls how 
often WinFrotz chooses to refresh the display as it is printing.    With “Very Frequent” 
selected, WinFrotz will update on any change and make sure the screen scrolls smoothly.    
This mode can be slow in full color mode if your Windows desktop is in 16/24/32 color depth. 
With “Frequent” selected, WinFrotz will continuously update the display for each line printed 
or area erased.    With “Infrequent” selected WinFrotz will update the display only when it is 
ready for you to read it (at a MORE prompt for instance).    Infrequent mode is faster, but can 
actually appear slower due to the jerkier nature of the display.

It’s often best to play graphical games in Infrequent mode; that way you don’t watch all of 
the graphics being updated.    However for text games many people prefer frequent or very 
frequent.

Lock Window Size:
Use this option when you are happy with your screen option and don’t want to accidentally 
resize it.    It will basically prevent you from changing the screen size as long as long as it is 
checked.

Please note that selecting “Lock Window Size” and then resizing fonts, especially the status 
font, can cause some games to corrupt their displays.    This is because WinFrotz will no 
longer be able to compensate for different font sizes by changing the size of the display 
itself.





Graphics Options

This dialog box controls how WinFrotz handles V6 (graphics) story files.    It is broken into 
three sections:

Emulate:
This box will let you select which PC graphics mode WinFrotz will emulate as it runs the story
file.    CGA mode is a two color mode which will use your chosen foreground/background 
colors.    MCGA mode is a 16 color mode drawn from a large palette and is the recommended
choice unless the game you are running doesn’t support that mode.    EGA mode is a 16-
color mode with a very limited, fixed palette.    EGA mode typically looks worse than even 
CGA mode.

Screen Size:
When you run a V6 game, WinFrotz will automatically resize to one of the sizes specified in 
this box.    This will have no effect on your chosen screen size for other games; it’s particular 
to V6 games only.    By picking a size here you are determining how far WinFrotz should scale
the display - since most of the display modes were far to small or the wrong aspect ratio to 
display under Windows.

V6 screen sizes are limited to three choices: 640x400, 960x600, and 1280x800.    These work
into convenient multiples of the base resolutions used for the original games. WinFrotz will 
always handle the aspect ratio differences and choice of how to scale on the X and Y axis 
itself, but the Z-machine games sometimes do not deal with this well at all.    For maximum 
compatibility it is recommended that you use 640x400 mode (1280x800 will also work well, 
but it’s pretty large).

Font:
This font is separate from your choices for other types of games (the status and display 
fonts) and will be used only for V6 games.    It is only font that will be available in your V6 
games (although there will still be bold/underlined variants if you choose to display them 
that way).    WinFrotz will allow you to only pick a fixed-pitch font (required) and will tell you if
the size isn’t likely to be compatible.    Many of the V6 games do not work well with 
particularly large or small fonts.

Even with all the effort WinFrotz makes to correctly emulate the behavoir of the Z-Machine in
V6 games, be aware there are a few small quirks left. For instance, in Zork Zero small 
graphics are used as icons for the room the player has moved to; once in a while the bottom 
line of these icons will be clipped off the bottom of the screen. This is because the font and 
screen size you are using is substantially different from the original game, and in a few 
places the original has hard-coded assumptions of the ratio of the font to the icon size. It 
can’t be helped in other words, although you can try a slightly different font size to see if it 
corrects the error.



Version 6 (graphics) games

These games feature graphics displays during the course of the adventure. You must have 
the actual graphics files, which usually end with a .MG?, .EG?, or .CG? extension, signifying 
MCGA, EGA, or CGA graphics.    If you don’t have the graphics files for a game that is 
graphics compatible, check on ftp.gmd.de to see if there are some there (most of them are). 
WinFrotz can play these games but there are some caveats due to the substantial difference 
between the Windows graphics system and the original PC graphics modes; these are fully 
explained under the View/Graphics help entry.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using WinFrotz and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
WinFrotz.    There is also some system information displayed in this dialog box, including the 
relative speed with with WinFrotz is emulating the Z-Machine (this can be heavily influenced 
by a variety of factors, so take the number with a grain of salt) and the number of Z-Code 
operations that have been executed so far in the current story file.



Context Help command 

Use the Context Help command to obtain help on some portion of WinFrotz.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the WinFrotz window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

WinFrotz does not scroll the main display. It will however scroll in the scrollback mode (Ctrl-
L).



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the WinFrotz window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    WinFrotz determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    WinFrotz determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

WinFrotz will always initialize the font dialog box with the currently selected font for the type
you want to change, and limit your choices to only valid ones.    You can use the font dialog 
to preview what the font will look like when it is displayed.    Remember there at times when 
the font selection will not immediately result in a change in your display, however text 
printed from that point onward in the font you were changing should reflect the change.



Choose Color dialog box

WinFrotz will allow you to select any color for any item in the Colors menu.    There are 
certain combinations of colors that could result in difficult or impossible to read displays; if 
you find the display not making sense after you changed a color, you should probably select 
a different choice for that color.

The bottom of the choose color dialog box is filled with the custom color palette of WinFrotz.  
This is saved and reloaded every time you run WinFrotz; so if you tend to switch between 
certain colors it makes it easier if you store them here.    The first six colors in this list are 
reserved by WinFrotz itself and represent the foreground, background, inverse foreground, 
inverse background, bold and emphasis colors respectively.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Compatibility

It is the goal of the author to make WinFrotz fully Z-Machine compliant; that is, make it able 
to run all versions of Z-Machine code.    However for this release there are games known not 
to work right or at all under WinFrotz:
· Beyond Zork (Infocom) Uses a special font not available yet - does not work

In general WinFrotz does well with all the other games; but there are specific circumstances 
that can confuse certain stories because WinFrotz features capabilities the original Z-
Machine designers never planned for (like dynamic resizing of the display area).    If you are 
having problems with a particular story, first try selecting an identical fixed pitch font for 
both the status and display fonts, then resize your screen to 80x25 characters and restart 
the story.    If you still have problems, e-mail rich@kesmai.com with specifics so I can find out
what is causing it.



Infocom

Infocom is the now defunct company that designed the original Z-Machine concept and 
wrote the original set of adventure games that became the backbone of the interactive 
fiction genre (there were plenty of other game companies that produced adventures, but 
Infocom is generally acknowledged as having the best talent and being the all-around 
pioneer of the field).

Many people (the author of WinFrotz included) believe that the work done for many of the 
original, straight text Infocom adventures is some of the best writing ever done for computer
game media.    Since the designers were not able to depend on eye catching graphics or 
surround sound, 3D or any of the techno gadgets found in games today, they concentrated 
solely on a solid game and writing that was the principle feature, rather than a secondary 
one, to the story.

Although Infocom no longer exists, the name and game rights to their products are owned 
by Activision.    Activision has repackaged the original Infocom games in a single CD called 
“The Masterpieces of Infocom” which can be purchased for under $20 US dollars.    As there 
are over 30 games on it, and all are in a format ready to use with WinFrotz, it’s a good 
companion to WinFrotz.    More information is available from the Activision website at 
www.activision.com (I do not work for, nor am compensated in any way, by Activision - nor 
do they have knowledge of or support WinFrotz. Please do not call Activision with a WinFrotz 
problem!).



Obtaining Story Files

There are several different ways you can obtain story files to play with WinFrotz.    If you own 
any of the Infocom adventures, even if they are old, if you can find a way to transfer files 
from those old disks to your Win95 or NT machine you are probably in luck.    Just look for a 
file that ends in .DAT, as that is generally the naming convention used by Infocom (it will 
also usually be the largest file on the disk).    Sometimes for older platforms the story data 
and executable were merged into one file; for these you may have to look for a utility that 
splits the files up (read on).

If you want all of the Infocom adventures in a single easy to use place you can obtain the 
Masterpieces of Infocom disk from Activision (just follow the help link to Infocom to find out 
about it).

There are also free story files available.    The most complete location for these is the ftp site 
ftp.gmd.de which contains just about every piece of interactive fiction written that is 
publicly available.    Look in the directory /if-archive/games and search around; generally 
anything that ends with a .dat or .z?? extension is useable (there are story files that cannot 
be read by WinFrotz because there are other data formats besides the Z-Machine that 
WinFrotz does not understand).

You can also check the WinFrotz home page at:

http://www.cris.com/~Twist/WinFrotz

Where I intend to keep reasonably up to date links and info on getting games and the latest 
version of WinFrotz itself.



Editing Keys

Not surprisingly most of the work in WinFrotz is done from a text editing line (most 
interactive story files being text based).    WinFrotz supports a variety of editing and hot-keys
from past versions and also familiar to regular Windows users:

    Alt-A             - alias menu (also Options/Alias)
    Alt-D             - debugging menu (Options/Debugging)
    Alt-N             - new game (restart) (File/Restart)
    Alt-P             - turn on input line playback (File/Open/Recording)
    Alt-R             - input line recording on/off (File/Save/Recording)
    Alt-S             - set the random seed
    Alt-U             - multiple UNDO (even for old V1 to V4 games)
    Alt-X             - exit game (quit)

    Ctrl-A      home              - move to beginning of line
    Alt-B       ctrl-cursor left  - move to previous word
                ctrl-cursor right - move to next word
    Ctrl-B  or  cursor left       - move one character to the left
    Ctrl-D      delete            - delete character below cursor
                ctrl-delete       - delete word below cursor
                insert            - toggle overwrite mode on/off
    Ctrl-E      end               - move to end of line
    Ctrl-F      cursor right      - move one character to the right
    Ctrl-H      backspace         - delete character to the left
                ctrl-backspace    - delete word to the left
    Ctrl-L      scrollback        - view scrollback buffer
    Ctrl-N      cursor down       - get next command
    Ctrl-P      cursor up         - get previous command
    Ctrl-T                        - transpose characters
    Ctrl-U      escape            - delete whole input line



Alias Menu

WinFrotz allows the creation of alias files to make repetitive statements easier to type.    The 
Aliases... menu item brings up a dialog box that allows you to edit these aliases or 
abbreviations.

The dialog box will display a list of the current aliases in the form:

text -> replacement

Where “text” is what you would type in and “replacement” is what WinFrotz would replace 
that with.    The dialog box allows you to highlight an alias and delete it, create a new alias, 
delete all aliases, and enable or disable aliases (if you disable aliases, your list will be kept, it
simply won’t be used until you re-enable them).



Alias Menu

This dialog box will allow you to enter an alias or abbreviation for a section of text. In the 
first entry box, you type the text you wish to use as an abbreviation, in the second, the text 
it will be replaced with. So you might type “foo” in the first entry box and “the big foo bar” in 
the second. After that whenever you type “foo” on a line of text entry, it would be replaced 
with “the big foo bar”. Alias entries are not recursive.



Debugging Menu

This dialog box allows you to turn on various debugging or “cheat” options for the Z-Machine
WinFrotz is running. They are broken down as follows:

Watch Attribute Assignment: Generates messages when the Z-Machine changes the 
characteristics/attributes of an object in the game

Watch Attribute Testing: As above, shows the testing of the attributes on an object.

Watch Object Movement: Generates messages as the Z-Machine moves objects around (non 
player characters are thought of as “objects” so you can watch them move with this).

Watch Object Locating: Generates messages when objects are located

Set Piracy Bit On: Turns the “piracy bit” on for the game, although no games are known to 
use this.

Set Tandy Bit On: Several Infocom games will behave slightly differently with the Tandy bit 
set, censoring some words for this “family” brand that was sold through Radio Shack.

All options in this menu apply only to that session of use. They are not saved in the registry 
as this would lead to confusion and problems with overly verbose output.



Sound Menu

The sound dialog box simply allows you to specify whether WinFrotz will attempt to play 
sounds in those games that support it (Sherlock and Lurking Horror, currently).    You might 
select this off if you are having problems with sounds, or you don’t want to hear them.

In addition you can adjust the volume with which sounds are played.    This volume is 
relative to your current wave output volume specified in the Windows sound control panel.   
If you have the slider all the way to the right, WinFrotz will play sounds at the maximum 
volume for wave output, not at the maximum volume your sound system is capable of 
supporting.

This dialog will also indicate whether the story file you are using has even attempted to load 
and play a sound yet. This can be a useful diagnostic if you are trying to determine whether 
the story file is sound-capable or not; not all versions of Lurking Horror or Sherlock even play
sounds (complete documentation on how to modify them is at ftp.gmd.de). It may also just 
indicate that you haven’t reached a point in the game where it tries to play a sound yet.

Sound settings are saved in the Registry so WinFrotz will remeber what volume you want, 
etc.



Scrollback Buffer

The scrollback buffer displays the last 32K or so of the transcript that is recording while the 
story file is played.    You can use the scrollback to copy text that you want to input; simply 
highlight the text using the mouse or arrow keys and use the standard windows Ctrl-C to 
copy it to the clipboard.    Once back to the WinFrotz entry line, use Ctrl-V to paste it in.

The scrollback buffer is read only (you can’t insert text here) and possibly represents only 
part of the entire transcript; the most recent part.    To obtain a record of the entire transcript
save it to disk using the File/Save/Transcript menu entry.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




